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In nature, pollen germination occurs on the stigma of a flower and the pollen tube elongates towards the 
flower’s ovule. Pollen germination and elongation is a dynamic process during which pollen must respond to 
different signals and develop a complex structure to deliver sperm cells for fertilization. Pollen germination 
can be easily visualized using an in vitro setup and a compound microscope. Students learn about the 
advantages and disadvantages of different in vitro assay methods, test multiple flower species, modify basic 
germination media and design an experiment related to pollen germination that integrates evolution and cell 
biology. 
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Introduction 
 

 This lab exercise is easy to set up and 
inexpensive. The lab can be set up in a couple of 
hours using common lab equipment. Many flower 
pollens will germinate in vitro allowing students to 
investigate flowers of interest to them. Nicotiana 
tabacum and Hemerocallis can be used as starting 
species. Extensions to the lab can include 
comparing different flower species, modifying the 
basic germination media and having students design 
their own experiment. The experiment itself does 
not require sophisticated content background, 
allowing the experiment to focus on the scientific 
method. 
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Student Outline 
 
Students will: 

• Critically read a lab procedure 
• Compare the germination of pollen in two different in vitro methods (hanging drop method and agarose pad method 
• Observe pollen tube germination in a variety of flowers 
• Calibrate the ocular radical in the microscope for different objective lens. 
• Measure the length of pollen tubes using Image J. 

	
  

 
                             Figure 1. Anthers releasing pollen. 

 
Basic Background Information on Pollen Germination 
 

Pollen germination occurs when a pollen grain develops a pollen tube. In nature, pollen germination occurs on 
the stigma of a flower and the pollen tube elongates towards the flower’s ovule. Sperm will travel through the pollen 
tube to fertilize the ovule. The evolution of pollen eliminated the dependence on standing water for fertilization in seed 
plants. 

Pollen develops in the anthers of the stamen of the flower. The anther has four pollen sacs held together by 
connective tissue. Each pollen sac has microsporocytes (microscope mother cells), which divide by meiosis to produce 
microspores. Each microspore divides by mitosis to produce either a 2-cell microspore or a binucleated microspore. 
Each microspore differentiates into a pollen grain. 

Pollen grains range from 6 to 100 micrometers and have species-specific morphology. The wall of the pollen 
has three layers: the inner intine wall, the outer exine wall and the pollen coat. The pollen walls have modifications to 
allow for shrinking and swelling of the grain and thinner areas (apertures) where the pollen tube can break though the 
pollen wall. 

Pollen germination and elongation is a dynamic process during which pollen must respond to different signals 
and develop a complex structure to deliver sperm cells for fertilization. Pollen germination can be visualized easily. 
This system is a simple model to study cell to cell interactions and environmental effects on development. 
 
Pollen Germination Assays  
 
Hanging Drop Procedure 
 

 The hanging drop procedure is used to observe living organisms over time where desiccation could be 
an issue. The surface tension of the drop concentrates the cells to the edge of the drop. Oil immersion cannot be 
used with a hanging drop preparation. 
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1. Prepare humidity chamber by placing filter paper in Petri dish. 
2. Moisten paper with water. 
3. Clean microscope slides and cover slides using ethanol. Rinse with water and dry using a Kimwipe. 
4. Prepare a slide with a slide chamber where the hanging drop can be inverted onto the chamber. 
5. Lightly grease the bottom of a gasket. Place the gasket onto a regular microscope slide or a depression 

slide. 
 

 
Figure 2. Greased gasket placed on microscope slide. 

 
6. Determine the amount of media you will need to add to the cover slip to get a hanging drop (20 to 100 

micrometers). The larger the drop, the less likely the drop will evaporate. 
7. Flip the coverslip over and place onto the gasket. 

 

 
Figure 3. Flipped coverslip

 

 
Figure 4. Coverslip on top of gasket. 

8. Observe the drop under the low power objective. 
9. Use the edge of the drop to focus the microscope. 
10. Change the objective lens to 10X and refocus. You cannot use the 40X objective lens with this 

procedure. 
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Obtaining Pollen 
 

1. Observe the flower. 
2. Identify the different parts of the flower. 
3. Find the anthers. 

• The best pollen to collect for germination comes from anthers that have burst or split open. The 
process is referred to as dehisce. You can quickly tell if the pollen is mature by gently brushing 
your finger across the anther. If you see a residue of pollen on your finger, the pollen is most 
likely mature. 

4. Remove a pipette tip using the P200 micropipettor. 
5. Eject the tip into your fingers. 
6. Gently rub the anther with the pipette tip until a small amount of pollen is transferred to the needle. 
7. Transfer the pollen to the drop of media on the cover slip by tapping the tip with your finger. 
8. Invert the cover slip over your slide. 
9. Record the time. 

 
Observing Pollen Tube Growth 
 

1. Observe the pollen under 100 x magnification 
(10 x objective lens and 10x ocular lens) 

2. Record the shape, size and any unique features of the pollen grains. You may draw the pollen shape on 
a piece of paper and then take a photo using your cell phone (will be demonstrated in class). 

3. Check the pollen every 30 minutes until the pollen tubes begin to grow. Keep the slide in the humidity 
chamber between observations. You may search through the fields of views until you find a field of pollen 
with a good density of pollen. 

4. Once the pollen tubes have begun to germinate, record the time, percentage of pollen that has germinated 
and the length of five pollen tubes every 10 minutes for 30 minutes. 

 

 
   Figure 5. Narcissus sp. (Daffodil) pollen germination.  

 
Agarose Method 
 
 Agarose gels are transparent, easy to make and can be made with a variety of buffers. 

 
1. 1% molten agarose can be found on a hot plate. 
2. Clean a microscope slide. 
3. Warm the microscope slides by placing the slides on the edge of the hot plate. 
4. Using a glass pipette, add 1 drop of agarose to the warm slide. 
5. Allow the agarose to spread over the warm slide for 15 seconds. 
6. Place a second slide perpendicular to the first slide. 
7. Remove the slide from the hot plate and allow the slides to cool. 
8. Prepare humidity chamber by placing filter paper in Petri dish. 
9. Store your agarose slide in the humidity chamber when not in use. 
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Observing Pollen Tube Growth 
 
1. Remove the slide from the humidity chamber. 
2. Dry the bottom of the slide using a Kimwipe. 
3. Observe the pollen under 100X and 400X magnification 
4. Record the shape, size and any unique features of the pollen grains. You may draw the pollen shape on a piece of 

paper and then take a photo. 
5. Continue to check the pollen. 
 
Compare the Pollen Growth between Different Flowers 
 
1. Collect pollen from two different flowers. 
2. Use either the hanging drop or the agarose method assay to determine pollen growth. 
3. Decide on a variable to measure. 

• Time it take for the pollen tube to reach one pollen grain diameter 
• How long the pollen tube will be after a pre-determined time 
• Percentage of pollen that germinates 

4. Observe the pollen under 100X and 400X magnification and record data. Take a picture of the pollen with the 
eyepiece reticule present in the view. 

5. Calibrate your eyepiece reticule using a stage micrometer (See Appendix A). 
6. Using Image J, calculate the length of a typical pollen tube from the image you took on your cell phone. (See 

Appendix B). 
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Materials 
A List of Equipment and Supplies Needed for 
a Class of 25 Students 
 
Basic Germination Media: 

1mM KCl 
0.1 mM CaCl2 
1.6 mM H3B03 
10% glucose 
1% agarose  

 
Regular glass slides  
Cover slips 
Petri dish (large enough to up a glass slide in)  
Flowers 
Compound microscopes  
Micropipettors (200ul)  
Slide warmer 
Stage micrometer  
Microscope  
Eyepiece reticule 
 

Notes for the Instructor 
 

 This manuscript is based on an undergraduate 
biology lab at University of California Irvine. Students 
work with pollen germination for multiple weeks. 
Initially, they explore the two different assays which 
will be presented in the workshop. Later students 
expand on these assays by bringing their own flowers, 
modifying the germination media components and 
finally designing their own experiments. 
 Image J is relatively easy to use by students 
with little supervision. Students are given a 
PowerPoint to help them work through the set of 
images using the screen shots as part of an 
introduction to data analysis. Students are given a 
practice quiz to help them determine if they are having 
any problems using Image J, before they are given a 
class quiz. The most common student error is 
reporting an area measurement when doing linear 
measurements. Image J reports both a length and area 
value for each line measurement, because the line has 
both a width and a length. The results from the quizzes 
are used as data to illustrate variability. Student 
routinely use Image J for every lab activity in the UC 
Irvine Cell and Developmental laboratory. Students 
report using Image J in microbiology, molecular 
biology labs and with their own independent research. 
Different sets of images could be designed to be more 
closely related to other laboratory experiments. 
 
Easter Eggs: Errors Intentionally Introduced 
to Encourage Students to Carefully Read the 
Lab Procedures 
 
 Before a lab, students are told the procedures 
may contain errors, which I call Easter Eggs. These 
errors help student learn the skill of trouble shooting 

an experiment. The following are a few of the 
common Easter Eggs I include in the procedure. I 
usually include additional errors and continue the 
inclusion of Easter Eggs in all future procedures. 
 The students are asked to “Gently rub the 
anther with the pipette tip until a small amount of 
pollen is transferred to the needle”. The step before 
asked the students to use a pipette tip. 
 In the agarose method, students are asked to 
“Place a second slide perpendicular to the first slide, 
after they have added a few drops of agarose to a 
warm slide”. If students place the additional slide on 
the agarose and then try to remove the second slide 
after the agarose has dried, they will not get a nice 
even agarose pad. Frequently students will keep 
repeating this step over and over, with the same 
results. You can guide the student by asking what 
physical properties the agarose pad should have. The 
pad should be flat but also thick enough to not dry 
quickly. The best way to achieve a flat pad is to not 
place a second slide perpendicular to the first slide. 
 Also, no instruction indicates when the pollen 
needs to be added to the agarose. Sometimes students 
will add the pollen while the agarose is still hot. 
 The students are given an image of Narcissus 
sp. (Daffodil) Pollen Germination. Although the 
flowers are not Narcissus sp. When asked to report the 
genus species of the plant they are working with, 
many students report Narcissus sp. You can add 
additional “Easter Eggs” to the procedure. 
 When students were asked “what were the 3 
most important skills learned from this laboratory 
exercise?”, the most frequently reported are: critical 
thinking, scientific doubting, results analysis results 
and experimental design modifications 
 
Student Comments on the Pollen 
Experiment: 

• I learned to challenge protocols; there may 
be a better alternative to a method. 2) I 
learned to work together in a group with 
other individuals, this is especially 
important since science requires 
collaborations. 3) I learned that it’s more 
important to understand why the results 
occurred rather then just accepting the 
results. 

• Thinking critically, having a plan, 
questioning everything that even someone of 
authority tells you (Easter eggs in protocols) 

• The ability to read scientific papers. 2) 
Preparing for lab by analyzing the protocol. 
3) Asking for help when needed. 

 
 
 
 

• During an experiment, it is important to 
constantly be thinking of why certain 
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things in the lab are done the way they are, 
why certain reagents are added and their 
importance, and explanations for results 
that are obtained. 2. It is also important to 
have the skill of constantly be 
documenting what is being done during the 
lab and taking pictures for future use. 3. I 
also learned the important skill of keeping 
an open mind set when doing a new 
experiment as it can help me learn new 
perspective on things. 

• Thinking CRITICALLY about what I am 
doing and WHY. I believe this was 
emphasized MUCH more in this lab 
compared to previous labs I have taken, and 
that's awesome. 2. Working in groups. 
Previous labs I have taken also focused on 
group work, but for some reason, I feel like 
I learned more about how to work well in a 
group compared to other labs. 3. Always 
have aback-up plan. There have definitely 
been times where things could have gone 
(or did go) wrong. Those times have taught 
me to always have a plan B. 

 
Sample Results 

 
 Depending on the flower, pollen tubes can be 
seen within 15 to 30 minutes after they have been 
exposed to germination media. 

 
Outline to Present the Laboratory  
 

1. Present the background of pollen 
germination. 

2. Demonstrate the set-up of the two assays. 
3. Allow time for the participants to set up their 

own germination assays. 
4. Demonstrate how to calibrate the microscope 

using a stage micrometer.  
5. Demonstrate how to take picture of the pollen 

using a cell phone. 
6. Demonstrate how to use Image J and the 

photos taken from the cell phone to calculate 
the length of a pollen tube. 

7. Allow time for participants to complete the 
activities. 

8. Reflect on the experiment, 
9. Show examples of student work. 
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Figure 6. Day lily pollen (Hemerocallis sp.) one hour after pollen was added to germination media (hanging drop 
method). 
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Appendix A 
Microscope Magnification Calibration 

 
Questions to be Answered 
 
What was the conversion factor for your 10x and 40x objectives? 
 
 
Materials 
 
Stage micrometer 
Microscope slide with a ruler etched on the glass 
A typical stage micrometer is 1 mm long with 10 major divisions and 10 minor divisions (100 total divisions). 
Each division is 10 micrometers or microns (µm) 
Confirm the micrometer scale, because some micrometers can be 2 mm long. 
Eyepiece reticule 
(A small piece of glass, fitting in the ocular lens, with a ruler etched on the glass) 
 
 
Procedure 
 
Calibration of the Microscope 
 
1. Focus the stage micrometer under the 10X objective lens. The lines on the stage micrometer represent REAL 
units. Each division has a length of 0.01 mm (10 µm). 
 

 
 
2. Focus the eyepiece reticule using the focus ring on the ocular lens. The eyepiece reticule lines represent 

ARBITRARY units (au). 
 

 
 
3. Adjust the distance between the ocular lenses until the interpupil distance is correct for you. Move the ocular 

lens apart and gradually bring the lens closer together until you only see one image through both of the lens. If 
you do not correctly adjust your interpupil distance, you can get a headache when looking though the 
microscope. 

 
4. Rotate the eyepiece reticule until the ruler is parallel to the stage micrometer. 
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5. Move the stage micrometer using the stage controls until the two “0” points are aligned. 
 

6. Find another point where the two ruler lines align. Record the 
number of lines on the stage micrometer. Record the number 
of lines on the eyepiece reticule. 

 
7. Multiply the number the number of lines on the stage micrometer by 0.01mm to determine a REAL length in 

mm. 
 
8. The conversion factor will be the real length divided by the number of lines on the eyepiece reticule. 

 
9. The number will be the conversion factor you will use when measuring an object on the stage. The 

conversion factor units are mm per au (arbitrary unit). 
 

10. You can convert to mm to µm by multiplying the conversion factor by 1000. 
 
11. Repeat the calibration for the 40X objective (steps 1-8) 

 
Example 

(The reticule lines were colored red to help distinguish the reticule lines from the micrometer line.). 
 

 
 

73 arbitrary lines (red) on the ocular reticle line up with 75 lines on the stage micrometer. Each line on the 
stage micrometer equals 0.01mm or 10 microns (µm) 
75 lines on the stage micrometer are equal to 750 microns. The 
conversion factor is 750 microns divided by 73 au. 

 
 
Measuring an Object under the Microscope 

 
1) Align the eyepiece reticule along the length you wish to measure. 

 
2) Count the number of divisions on the eyepiece reticule. 

 
3) Multiple the number of divisions by the conversion factor for the objective lens used. 

 
4) Remember to include all units. 

 
 
 

	
    

0 10 20 30 40 50 60 70 80 90 100 
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Appendix B 
Using Image J to Measure Pollen Tubes 

 
From: 
Mauzy-Melitz, D. Image J. In K. McMahon (Ed.), Tested Studies for Laboratory Teaching Proceedings of the 

Association for Biology Laboratory Education. ABLE Eugene 2014, Vol. 36. 

Introduction 

An image is more than just a beautiful picture. For scientists, images contain a wealth of information. Image 
processing can complement many of the current biology laboratories. Image J is a free, easy to use image processing 
program, developed by the National Institutes of Health, widely used in research applications. Image J also supports 
standard imaging processing functions allowing students to crop, manipulate contrast or subtract background. Java 
plugins and macros have been developed by Image J users to expand the functionality of the program. Multiple 
tutorials as well as YouTube videos are available to help users. With almost every aspect of Image J. At the 
University of California Irvine, Image J is used in the Developmental and Cell biology labs to give students an 
appreciation for microscopic quantitative techniques. Students analyze their own images and images obtained from 
research. Measurements, conversion from pixels to micrometers, area determinations, density profiles, histograms 
and particle counts are typical Image J applications. The mini-workshop presented during the 2014 ABLE conference 
is similar to material presented to undergraduate students in a scientific writing course that is a perquisite to all 
biology laboratories. 

Objective 

Students in biology laboratory courses frequently use microscopes to visualize experimental results but 
rarely analyze the results. Introducing students to Image J, a free simple image processing program, can promote 
quantitative skills into the visualization process. These skills can be later used by the students in research 
laboratories. 

Materials 

Image J program downloaded from http://rsbweb.nih.gov/ij/. The Image J program can be downloaded into a 
flash drive to facilitate distribution. 

Set of practice images. Practice images should include an image of an object with a centimeter ruler (Figure 
1), a microscope image of a stage micrometer with a scale bar included, (Figure 2) images of objects seen under the 
microscope at the same magnification as the stage micrometer slide (Figure 3). 

 

 
Figure 1. Photograph of a trilobite fossil with a centimeter ruler. 
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Figure 2. Microscope image of a stage micrometer taken with a 40x 
objective lens. Each division of the stage micrometer is equal to 10 
micrometers. Scale bar is equal to 250 micrometers. 

 

 
Figure 3. Microscope image of Echscholzia californium pollen germinating. The 
image was taken with the same objective lens and microscope as the image in 
Figure 2. 

 

Methods 
 

 The Image J commands for each of the process are outlined below. An image must be opened in Image J for 
the program to function correctly. The Image J program window consists of two bars, a menu command bar with 
pull downs and a tool bar. The menu commands bar consists of the major commands: File, Edit, Image, Process, 
Analyze, Plugins, Window and Help. Mac based computers will have the Menu command bar at the top of the 
screen. PC based computers will have the command bar and the tool bar attached somewhere within the screen. 

 
Change Line Color and Width 

 
The default line width is one and the color is yellow. For some images, either the line width or the color 

may need to be change to allow for better visualization. 
1. Edit > Options > Line Width 
2. Edit > Options > Colors > Selection 
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Length Measurements 

 
Length measurements are the most common measurements made in most biology laboratory activities. If 

the measurement is for a straight object, the Straight Line Tool should be used. The Segmented Line Tool is used 
for measurements of nonlinear objects. The Freehand Line Tool is available from the pull down menu of the 
Straight Line Tool with a icon of a wavy line instead of a straight line. Figures 1, 2, and 3 should be used to 
demonstrate length measurements. Figure 3 will require the use of the Freehand Line Tool. 

 
 
 
 

1. Select Straight Line Tool. 
2. Draw a line while holding down on the right hand mouse button. (Ctrl click for Mac) 
3. Click on Analyze > Measure (Shortcut key: Ctrl or Command M) 
4. Length in pixels will be displayed in a Results window (window may be hidden behind image) 
5. Other Line tools are Segmented and Freehand line tools (Right click to see line choices) 

 
Set Scale 

 
The default measurement value is in pixels. If the image has a ruler, stage micrometer or scale bar, the 

pixel values can be converted into metric measurements. Figure 1 of the Trilobite includes a centimeter ruler. Figure 
2 is of a stage micrometer with the distance between each interval equal to 10 micrometers. Figure 3 of the 
California poppy pollen germination was taken with the same objective lens as figure 2. The value for the scale bar 
can be determined for Figures 3, 4 and 5 from figure 2. It is important to have students confirm their measurements. 
A simple confirmation that the set scale is working correctly is to measure the distance between 4 and 5 on the 
centimeter ruler in figure 1. 

 
1. Select Straight Line Tool 
2. Draw a line while holding down on the right hand mouse button across a ruler or scale bar. 
3. Click on Analyze > Set Scale 
4. Click on Global (Need to confirm scale next time you open a new image with a different magnification) 
5. Confirm scale is correctly set by re-measuring the ruler. 

 
 

Area Measurements 
Area measurements are similar to linear measurements. The most common tool used is the Freehand tool 

(icon is a heart shaped object). Figure 4 and 5 should be used for area measurements. 
 

 

1. Use Selection tools (Rectangle, Oval, Polygon, Freehand)  
2. Same procedure as line measurements. 
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Appendix C 
Lab Report from a Student Designed Experiment Based on Pollen 

Germination 
 

Effect of Pistil Length on Pollen Tube Length 
by Audrey Park 

 
Introduction 
 
 The stigma is typically sticky to allow pollen grains transferred by the wind, animals, or surrounding water to 
easily adhere. Its stigmatic tissues and aquaporin channels help rehydrate the pollen, thereby polarizing the cell and 
assisting in initial germination. Pollen germination occurs when the sperm cells in a pollen grain migrate through the 
pistil towards to ovule, where the embryo sac is located. Pollen grains start off as a diploid microspore mother cell that 
undergoes meiosis to form 4 haploid cells. As the flower develops, the haploid cells undergo mitosis and differentiate 
into pollen grains (Raven, 2011). The pollen grains consist of a tube cell nucleus and generative cell. The tube cell 
nucleus aids in the elongation of the pollen tube while the generative cell develops into sperm cells. 

The pollen grain forms a very small aperture where the pollen tube protrudes and begins to elongate. Golgi 
vesicles that are present in abundant amounts in the apical tip of the pollen tube fuse and become a part of the tube cell 
membrane, ultimately expanding the wall. These vesicles are made up of pectin, which react with calcium to form 
cross-bridges, strengthening the apical tip to withstand the turgor pressure. 
 However, the acidic nature of pectin also triggers the release of cell wall-loosening agents to aid in the 
flexibility of the tip to allow elongation to occur. The pollen tubes receive signaling cues from the ovary to guide it 
downwards in the right direction. The sperm cell travels down the pistil through this pollen tube and penetrates the 
ovary at the base of the flower to form a zygote. The journey through the pistil of the flower is the most crucial part of 
germination because the stigma, style, and ovary interact and send signaling cues to the pollen grain (Kliwer, 2010). 

The focus of the paper will address the relationship between pistil length of a flower and its pollen tube 
lengths. There have been several studies conducted on the flower size and the rate at which its pollen germinates. 
According to a previous experiment, longer pistils have larger chemical gradients and stronger signaling cues, thus 
allowing 
the pollen tubes to continuously grow until the ovule has been penetrated (Hulskamp, 1995). This is crucial for plant 
reproduction because pollen on long pistils must be able to reach the ovary at the base of the flower in order for sperm 
to penetrate the embryo sac. In 1990, scientist E.G. Williams experimented with interspecific pollination with flowers 
of varying pistil lengths. His results showed that pollen from small flowers could not reach the ovule of flowers with 
long pistils. However, pollen tubes from a large flower would over-penetrate the ovule at the base of a flower with a 
short pistil (Williams, 1990). 

In this experiment, I used 7 different flowers of varying pistil lengths: Lonicera sempervirens, Tecoma 
campensis, Aloe arborescens, Cotyledon orbiculata, Penstemon centranthifolius, Tabebuia impetiginosa, and Digitalis 
purpurea. These flowers are all tubular, fused corollas, ranging in length from 7.4 to 2.6 centimeters and thrive in 
partial to full sunlight. With this said, is there a correlation between the pistil length of a flower and its respective 
pollen tube lengths? I hypothesize that flowers with long pistils will produce longer pollen tube lengths because the 
sperm cells must travel a further distance to the embryo sac, located at the base of the plant. 
 
Materials and Methods 
 
Plant Material and Study Site 
 
 For this experiment, seven different tubular, fused corolla flowers were tested: Lonicera sempervirens, 
Tecoma campensis, Aloe arborescens, Cotyledon orbiculata, Penstemon centranthifolius, Tabebuia impetiginosa, 
Digitalis purpurea. Tecoma campensis should be watered only once a week to allow the soil to dry between waterings. 
These flowers bloom into bright red-orange flowers that attract many pollinators, such as hummingbirds. 
 Cotyledon orbiculata and Penstemon centranthifolius are both desert succulents, and therefore, thrive in dry, 
arid environments. Aloe arborescens has active and rest periods. During its active growth periods, it is essential that 
the plant has access to full sun exposure. On the other hand, Digitalis purpurea should be kept in partial shade and in 
cool environments. Lastly, Lonicera sempervirens should ideally be watered regularly to keep the soil rich and moist. 
These flowers were all picked 2-3 days prior to testing from the University of California, Irvine arboretum (33.6635° 
N, 117.8530° W). 
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Microscopy 
 
 A compound microscope was utilized to measure pollen germination. Measurements were taken under 100x 
and 400x (10x or 40x objective lens x 10x ocular lens) in order to capture a clear image of the pollen. To adjust the 
image, the course and fine focus knobs found on the side of the microscope were utilized. The microscope was 
calibrated using the eyepiece reticule and stage micrometer before taking measurements in order to calculate the 
conversion factor: 

 
 

Pollination Experiment 
 
 To prepare for the experiment, 7 cover slips and microscope slides with ethanol and deionized water to ensure 
that there was no lingering residue. In addition, 7 gaskets were lightly greased with agarose gel and positioned on top 
of the microscope slides to prevent any movement. Using a P200 micropipette, 45 microliters of basic germination 
media were transferred onto the cover slips. Then, mature pollen from the flowers was collected with a pipette tip by 
gently rubbing the dehiscent anther lobes and lightly tapping it onto the germination media. The germination media 
was composed of 1 mM KCl, 0.1 mM CaCl2, 1.6 mM H3BO3, and 10% glucose. After transferring the pollen, the 
cover slip was inverted so that the hanging drop suspended over the gasket. When the slides were not in use, they 
were kept in a humidity chamber, made up of moistened filter paper in a petri dish in order to prevent the hanging 
drop from drying out. 

 
Statistical Analysis 
 
 Pollen tube growth was checked every 30 minutes and every subsequent 10 minutes after initial signs of 
germination appeared—the amount of time that had passed, percent germination, and the lengths of at least 30 
pollen tubes were noted. Means ± standard error was calculated for all measurements. With this information, 
multiple unpaired 2 sample t- tests were conducted in order to determine the significance between the average tube 
lengths and its respective pistil length. 

 
Results  

 
In Figure 1, the flowers are arranged from shortest to longest pistil length on the x-axis. From Digitalis 

purpurea to Lonicera sempervirens, the pistil lengths range from 2.6 to 7.4 centimeters. The objective of this 
experiment is to determine the relationship between pistil length and pollen tube length. Figure 1 displays a positive 
trend between the two variables—as the pistil length increases, the average pollen tube length also increases. The 
shortest flower, Digitalis purpurea was used as the negative control in this experiment because its pollen did not 
germinate in the 3 trials that were conducted (Table 1). On average, the pollen from the other 6 flowers germinated 
within minutes of being transferred onto the basic germination media at a rate of 2.24 micrometers per minute. A 
sample size of 30 pollen grains was observed and measured in order to determine the mean pollen tube lengths of each 
flower. Tabebuia impetiginosa, the second shortest flower, had an average pollen tube length of 31.3 micrometers 
while largest flower had the longest average pollen tube length of 717.15 micrometers. The calculated standard error 
did not have a particular trend but it tells the reader how accurately the sample represents the population. 
 To determine the significance of this positive relationship, six unpaired 2-sample t-tests were conducted with 
each individual flower compared to the flower with the longest pistil, Lonicera sempervirens. The null hypothesis was 
that the mean pollen tube length of each of the flower would be the same as the mean pollen tube length of Lonicera 
sempervirens (H0: µtc,aa,co,pc,ti,dp  = µls). The alternative hypothesis was that the mean pollen tube length of 
Lonicera sempervirens would be greater than the mean pollen tube length of the remainder of the flowers (Ha : µls  > 
µtc,aa,co,pc,ti,dp). 
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Figure 1. The flowers are arranged from shortest to longest pistil length (2.6-7.4 cm). The bar graph displays the 
mean pollen tube lengths for each flower in relation to the pistil size. Standard error bars are used to display the 
variance. 
 
 The expectation was to find the longest pollen tube lengths for Lonicera sempervirens because it has the 
longest pistil. Three trials were conducted over the span of two weeks; the results are charted in Table 1. From these 
three data sets, the set that most accurately represented the data was chosen and statistically analyzed (Table 2). After 
conducting the 2- sample t-tests, a set of p- values was calculated to determine the significance of the relationship 
between pistil length and its pollen tube lengths (Table 3). 
 

Table 1. The average pollen tube lengths (um) are depicted for each trial. 

 
 
 

Table 2. The table displays the statistical data for each flower. 

 
 
 

Table 3. The table displays the difference in length between each flower and L. sempervirens.  
The p- values from the 2- sample t-test are listed. 

 



Mauzy-Melitz 

Proceedings of the Association for Biology Laboratory Education, Volume 38, 2017 17 

 
 

 R² = 0.92664 
 

 
 

 
 

 
 

 
 

 
 

 
 

0 1 2 3 4 

Pistil Length (cm) 
5 6 7 8 

 
 
 If a significance level of α < 0.05 is used, the null hypothesis can be rejected for all the flowers. The p-values 
ranged from 2.70E-10 to 1.55E-34, therefore, we can conclude that there is statistical significance between the mean 
pollen tube lengths of each flower and Lonicera sempervirens. The data supports our hypothesis because it confirms 
that the length of the pollen tubes vary depending on the flower’s pistil length. In Table 3, we can see that as the 
difference in pistil lengths increases, the p- values decrease. This means that as the pistil lengths differ by a great 
amount, the probability that their pollen tube lengths are equal decreases. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 Figure 2. The positive correlation between the pollen tube lengths and pistil length is very strong. 
 
 Figure 2 depicts an x-y graph displaying the relationship between pistil length and pollen tube length. The R2 
value is 0.93, indicating that there is a strong positive correlation between the two variables. In other words, there is a 
clear increase in pollen tube length as the pistil length increases. The large R2 value also indicates that this model 
accounts for 93% of the variability along the regression line; the data fits the statistical model very well.  
 
Discussion 
 

Pollen collected from the different tubular flowers elongated readily in the basic germination media. Apart 
from the negative control, the remainder of the 6 flowers began germinating within 35 minutes of being transferred 
onto the media. The results of the conducted experiment support the initial hypothesis that flowers with long pistils 
produce longer pollen tube lengths. The strong, positive relationship between these two variables was confirmed by the 
R2 value and the conducted t-test. The R2 value of 0.93 proved that the size of the pistil of the flower determined the 
length to which its pollen tubes would grow. In addition, the resulting p-values, ranging from 2.70E-10 to 1.55E-34, 
indicate that there is a significant difference in pollen tube lengths between different flowers. As the pistil length 
difference between  
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Figure 3. Shown above are images of the flower that was tested and its respective pollen germination. 
A. Lonicera sempervirens had the longest pistil length and highest average of pollen tube lengths  
B. Tecoma campensis  
C. Aloe arborescens  
D. Cotyledon orbiculata 
E. Penstemon centranthifolius  
F. Tabebuia impetiginos 
G. Digitalis purpurea showed no sign of germination in all 3 trials that were conducted.  
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the positive control and each flower increased, the probability that the pollen tube lengths of both flowers 
would be equal decreased. Each p-value was less than 0.05, signifying that the average length of pollen tubes was 
highly dependent on its pistil length. 

The results of the experiment can be attributed to pollen-pistil interactions. The pistil, composed of the 
stigma, style, and ovary, is essential for pollen tube elongation (Figure 4). According to author Herrero, each 
component of the pistil supports the elongation of the pollen tubes—the stigma rehydrates the pollen before it enters 
the style where it is provided nutritive support, such as glycoproteins which guides the tube down towards the ovary 
(Herrero, 1996). In our experiment, the flower that had the longest  pistil length, Lonicera sempervirens, produced 
pollen tube lengths that were nearly 23 times longer than that of the shortest flower, Tabebuia impetiginosa. This can 
be attributed to the larger amount of support and nutrients provided to the pollen tube during its journey through the 
longer pistils. In addition, flowers that have long pistils tend to have stronger signaling cues and larger chemical 
gradients, ultimately resulting in longer pollen tubes. 
 
 
 
 
 
 
 
 
 

 
 
 
 

Figure 4. Image displays the anatomy of the pistil. 
 

Furthermore, the outcomes of the conducted experiment were analogous to those of the study mentioned 
previously by E.G. Williams. In his experiment, flowers with longer pistil lengths produced pollen tubes that 
penetrated past the embryo sac whereas pollen tubes from shorter flowers could not reach it at all. In our experiment, 
the relationship between pistil and pollen tube length had a definite, positive trend. 

To eliminate confounding factors and achieve accuracy, three trials were conducted in the span of two weeks. 
However, much of the data from trials 1 and 2 was inaccurate due to the heavy fog and rainfall that was experienced 
throughout the week. Flowers that bloomed upwards showed the most obvious signs of pollen damage while flowers 
that droop, such as Cotyledon orbiculata, were not impacted by the weather. The rain may have rehydrated the pollen 
grains prematurely before the flower had fully developed or may have completely shaken off all the pollen off the 
stigma. Biological replicates were tested—flowers of the same species were picked off of different branches to account 
for any confounding variables. 

This experiment is relevant to the scientific community because when pollinators, such as bees and 
hummingbirds, feed on nectar from a tubular flower, they are likely to get pollen on themselves. If the pollen falls off 
onto a stigma of a different flower, it could potentially produce a hybrid flower if the pollen tubes grow long enough to 
penetrate the ovary at the base of the flower (Mascarenhas, 1993). We now know that this is only possible if the pollen 
is from a long pistil flower and it falls onto a short flower. However, pollen from a short flower will not grow a pollen 
tube long enough to reach the base of a long pistil flower. If the pollen tube is successful in penetrating the ovary, this 
could produce new species of flowers by cross- pollination. In conclusion, the overall purpose of this report was to 
determine the relationship between pistil size and its average pollen tube lengths. We found that there is a very strong, 
positive correlation between the two variables, which confirms the initial hypothesis that longer pistils require longer 
pollen tube lengths in order for successful plant reproduction. 
 
Literature Cited 
 
Bosch, Maurice, Alice Y. Cheung, and Peter K. Hepler. “Pectin Methylesterase, a Regulator of Pollen Tube Growth.” 

Plant Physiology 138.3 (2005): 1334–1346. PMC. Web. 16 Feb. 2015. 
Erbar, Claudia. "Pollen Tube Transmitting Tissue: Place of Competition of Male Gametophytes." Int. J. Plant Sci. 

(2003): 265-77. Print. 
Herrero, Roles:M. "Pistil Strategies Controlling Pollen Tube Growth." Sex Plant Reproduction (1996): 343-47. Print. 
Hulskamp, M., K. Schneitz, and R. E. Pruitt. “Genetic Evidence for a Long-Range Activity That Directs Pollen Tube 

Guidance in Arabidopsis.” The Plant Cell 7.1 (1995): 57–64. PMC. Web. 14 Mar. 2015. 
Kliwer, Irina, and Thomas Dresselhaus. “Establishment of the Male Germline and Sperm Cell Movement During 



Major Workshop: Sex in the Garden 

Tested Studies for Laboratory Teaching 20 

Pollen Germination and Tube Growth in Maize.” Plant Signaling & Behavior 5.7 (2010): 885– 889. Print. 
Lush, W. Mary, Franz Grieser, and Mieke Wolters-Arts. “Directional Guidance of Nicotiana Alata Pollen Tubes in 

Vitro and on the Stigma.” Plant Physiology118.3 (1998): 733–741. Print. 
Mascarenhas, JP. “Molecular Mechanisms of Pollen Tube Growth and Differentiation.” The Plant Cell 5.10 (1993): 

1303–1314. Print. 
Raven, Peter. "Plant Reproduction." Biology. 6th ed. Boston: McGraw Hill, 2001. 842-848. Print. 
Williams, E.G. "Relationships of Pollen Size, Pistil Length and Pollen Tube Growth Rates in Rhododendron and Their 

Influence on Hybridization." Sexual Plant Reproduction 3.1 (1990): 7-17. Print. 
 

Mission, Review Process & Disclaimer 
 
The Association for Biology Laboratory Education (ABLE) was founded in 1979 to promote information 

exchange among university and college educators actively concerned with teaching biology in a laboratory setting. The 
focus of ABLE is to improve the undergraduate biology laboratory experience by promoting the development and 
dissemination of interesting, innovative, and reliable laboratory exercises. For more information about ABLE, please 
visit http://www.ableweb.org/. 

Papers published in Tested Studies for Laboratory Teaching: Peer-Reviewed Proceedings of the Conference of the 
Association for Biology Laboratory Education are evaluated and selected by a committee prior to presentation at the 
conference, peer-reviewed by participants at the conference, and edited by members of the ABLE Editorial Board. 

 
 

Citing This Article 
Mauzy-Melitz D. 2017. Sex in the Garden: Pollen Germination. Article 7 In: McMahon K, editor. Tested studies for 
laboratory teaching. Volume 38. Proceedings of the 38th Conference of the Association for Biology Laboratory 
Education (ABLE). http://www.ableweb.org/volumes/vol-38/?art=7  
 
Compilation © 2017 by the Association for Biology Laboratory Education, ISBN 1-890444-17-0. All rights reserved. 
No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any form or by any 
means, electronic, mechanical, photocopying, recording, or otherwise, without the prior written permission of the 
copyright owner. ABLE strongly encourages individuals to use the exercises in this proceedings volume in their 
teaching program. If this exercise is used solely at one’s own institution with no intent for profit, it is excluded from 
the preceding copyright restriction, unless otherwise noted on the copyright notice of the individual chapter in this 
volume. Proper credit to this publication must be included in your laboratory outline for each use; a sample citation is 
given above. 

 


